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Lesson summary 
Glacial lakes, whatever their origin and position with respect to glaciers, are strongly 
influenced by glacier dynamics that are extremely sensitive to climate change. Increasing 
melting rates induced by this phenomenon can have various effects among which the 
increase of both number and size of glacial lakes. Melting water from glaciers is in fact a 
main factor determining lake volume, but it also contributes to the loading of glacial 
sediments in the fronting lakes, whose waters are grey and very turbid. This lesson covers 
how we can use satellite data to classify the multiple lakes in the Sagarmatha National Park 
(SNP), an exceptional area with dramatic mountains, glaciers, lakes and deep valleys, 
dominated by Mount Everest, the highest peak in the world (8,848 m). The classification aims 
to recognize lakes colour and turbidity in terms of water reflectance brightness by focusing on 
finding potentially dangerous lakes with risk of outburst flood. 

 
 

GLaSS training material outline 
This lesson is part of the GLaSS training material. The complete training material outline is 
listed on http://data.waterinsight.nl/GLaSS/trainingmaterials/GLaSS_lesson_outline.pdf. 

Note that the lessons logically follow up on each other, the later lessons might require skills 
that can be acquired during the earlier lessons. 

 

http://data.waterinsight.nl/GLaSS/trainingmaterials/GLaSS_lesson_outline.pdf
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Abbreviation   Description 
Chl Chlorophyll 

EO Earth observation 
NIR Near Infrared 
SNP Sagarmatha National Park 
 

 



Global Lakes Sentinel Services (313256) 

 

 

4 of 23 

1 Introduction 
Global warming has resulted in a large-scale retreat of glaciers throughout the world. The 
evidence for this is particularly strong in high-altitude areas, such as the central Himalaya, 
where the widespread recession is evident from the rapid growth in the number and size of 
glacial lakes. The deglaciation processes are also revealed by the amount of suspended 
solids transported by melting glacier waters into the lake with consequences for light 
propagation in the water body. If glacier water influx into a lake increases, them the maximum 
suspended particle size and particle number density will increase, and this affects light 
scattering. For decreased meltwater input, absorption because of water increases and the 
preferential red absorption because of water are enhanced. In lakes that have no glacial 
input, lake water is clear, and there is almost no scattering or absorption because of 
suspended matter.  

Light propagations in water bodies can be successfully investigated by optical sensors which 
can be operated both from field-based and space-borne platforms. Whatever the observation 
scale, they allow the spectral water reflectance to be captured and then analysed in terms of 
shape and magnitude. Typically, field data are then used for satellite data processing and 
validations. 

In this lesson field measurements of water reflectance collected in October 2014 in five lakes 
in the Mount Everest region (Nepal) are analysed to provide reference data to classify the 
numerous lakes of SNP from two Landsat-8 images of October 2014 and September 2015. 
The classification aims to identify lakes depending on water reflectance spectra and 
consequently on water colour. A focus on lakes whose colour results grey is then performed 
as for these grey-turbid lakes (placed in proximity to glacier tongues having elongated shape) 
the risk of outburst flooding increases. 
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2 This lesson 

2.1 Research question 
Which Himalayan lake could cause glacial outburst floods? 

2.2 Training objectives / skills to gain in this lesson 
In this lesson, the main objective is the classification of lakes in Himalayan region through 
remote sensing products and techniques, on the basis of their own colour, to distinguish 
among lakes, those fed by glacier. 

• Lakes identification and surface extension assessment through remote sensing 
techniques, classifying image surfaces trough new GLaSS Prediction Tool 

• Assessment of lakes type through remote sensing colour 

• Masks generation for change detection 

• Classifying image surfaces trough new GLaSS Prediction Tool for the evaluation of 
new grey lakes on glacier tongues 

2.3 Required software and data 

Software and tools 
To complete this lesson tasks, the following tools and software are required or suggested: 

• BEAM (required, see Lesson #1). 
SNAP can't be used to complete this lesson tasks. 

Downloadable files 
• GLaSS_Training_Lesson7.pdf 

The main document of the lesson including exercises and questions. 

• GLaSS_Training_Lesson7_Answers.pdf 
A document containing answers to all questions proposed in the exercises. 

• GLaSS_Training_Lesson7_DataAndTools.zip 
Supplied data and tools, described below. 

The zip-file with supplied data and tools contain:  

A ‘Sample_data’ directory containing: 

• an atmospheric corrected Landsat 8 image of Himalayan region of 30th September 
2015 in BEAM-DIMAP format (‘L8_20150930_AtmCorr.dim’ and 
‘L8_20150930_AtmCorr.data’) 

• a subset of an atmospheric corrected Landsat 8 image of the same region of 29th 
October 2014 in BEAM-DIMAP format (‘Subset_L8_20141029_AtmCorr.dim’ and 
‘Subset_L8_20141029_AtmCorr.data’) 

• ‘InSituMeasures.csv’ and ‘coordinates_inSituMeasurements.txt’ containing 
respectively the values of some in situ measurements of reflectance and their 
coordinates 

• a shapefile containing the database of the Sagarmatha National Park largest lakes 
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‘LAKES_SNP.shp’, with central lake pixel coordinates and lakes ID. 

3 Exercise 

Part 1 EO products use for large and small lakes identification 
In this first part, a Landsat 8 product corrected for atmospheric and adjacency effects (i.e. an 
image containing reflectance values in each pixel) is used to identify large and small lakes 
extension. A mask of the lakes is generated exploiting the new Prediction Tool, to be used in 
the second part of the lesson, for lakes classification. 

Activities 
 Start VISAT, the BEAM interface (find it in ...\beam-5.0\bin). 

 Open L8 product of September 30th 2015: File>Open Product and choose 
‘L8_20150930_AtmCorr.dim’. 

 Expand the main folder and then ‘Bands’ folder: five bands are shown from 443 to 
864.6 nm. Right click on image name and choose Open RGB Image View…: 

  
Figure 1. RGB bands combination selection window: True Color default profile (left) 
and False Colour composition (right). 

 Confirm Nasa L1 True Colour profile: the RGB image is shown. Due to the clouds and 
snow brightness, the image could result dark. Use Colour Manipulation tab (on the left 
side) to stretch the image, to make lakes and land easier visible. 

 
Figure 2. Landsat 8 True Colour image on Himalayan lakes on September 30th 2015 
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shown in BEAM-VISAT and Products and Colour manipulation tabs (left side). 

 A second chance is to visualize the image in False Colour composition, choosing 
bands as in Figure 1(right). 

 
Figure 3. Landsat 8 False Colour image on Himalayan lakes on September 30th 2015 
in BEAM-VISAT. 

Look at the False Colour image. As you can probably see, in the image there are several 
lakes, with different shapes and colours, due to their different origin. 

In True Colour map, they appear blue, turquoise or grey and in False Colour they appear, 
respectively, almost black, blue and turquoise. This is because blue lakes are clear lakes 
which reflect almost anything in Near-Infrared (NIR) and very few in green and red bands. On 
the other hand, grey lakes are much more reflective in the whole visible-NIR spectrum, due 
to the presence of suspended sediments. Turquoise lakes represent a middle situation. 

To generate a mask containing lakes, several method are, in general, exploitable: importing 
existing shapefile, hand-drawing geometries on the image or exploiting colour, i.e. spectral 
characteristics, of lakes water. This last one is the most suitable in this case.  

Open the Spectrum View clicking on . Moving cursor on the image you can visualize how 
the spectrum of reflectance changes in shape and magnitude values moving across different 
surfaces. 

o What are the ranges of reflectance values in the image? 
What are the ranges of reflectance values for lakes? 
And for snow?  

In this lesson, in order to generate a lakes mask, the new Prediction Tool, developed in 
GLaSS project framework (See lesson 2 for further information on Prediction Tool 
functioning), is used to classify the image in six classes: vegetation, rocks, snow, clouds, 
shadows, lakes. 
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As shown in lesson 2, the Prediction Tool use a training dataset defined on a set of pixels 
chosen in the image to calibrate and validate a classification model, which in turn can be 
used to classify the whole image as like as other images. To define the training set, in this 
lesson the Magic Wand tool is used (See Annex I of GLaSS deliverable 3.6 (2014)). 

The next operations should be repeated for each class. 

 Open Magic Wand tool clicking on  . 

 Approximately, define the range of pixel values for each class: this option do not 
influence the results but it is only useful to get a comparison between values range 
and tolerance.  

 Do not apply any transformation on spectra (select Identity option) and use Distance 
for inclusion/exclusion test for pixels. 

 Define the tolerance: of course, you should adjust this value considering the 
homogeneity/heterogeneity of the class. You could start with 0.02. 

 
Figure 4. Magic Wand tool window. 

 Start collecting spectra: select  and click on some pixels of the surface you are 
considering, in different area of the image. In this way, you collect several spectra that 
Magic Wand tool uses to select pixels in the image through an inclusion/exclusion 
test. The more the pixels are heterogeneous, the less the test of inclusion will be 
strict. Pixels which pass the test are included in a new mask. If you notice (and it 
could probably happen in case of vegetation and rocks classes due to their 
heterogeneity) that tolerance is too strict, adjust it to higher values (for ex. 0.05). 

 Once you are satisfied with your result, open the Mask Manager  and change the 
name of the new mask created from ‘magic_wand’ to the name of the class. Finally 

clear Magic Wand results clicking on  and start again with a new class. 
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Figure 5. Masks used as training set for the Prediction Tool loaded on September 30th 
2015 image, created through Magic Wand Tool, and Mask Manager window showing 
colours legend. 

The new six masks generated can be now used as training set to feed the Prediction Tool. 

 Open the Prediction Tool . In the first tab (Training Set) select all the bands to be 
included in the model for classification. In the Available product masks table, all 
masks you have previously created are reported. Select the six classes masks and 
click on the left arrow to include them in the Selected training area table. In this way 
you have defined the training set of the model. A valid pixel expression can eventually 
added, but in this lesson we want all the image pixels to be included in the 
classification process. 

 Click on Train Model. 

 
Figure 6. Prediction Tool window – Training Set tab for image classification. 
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 Once the model is trained, choose the Model Training tab and click on Evaluate 
Model Performance. You can validate the results both through the confusion matrix 
(Figure 7) or with overall Accuracy Measurements. In the case shown in Figure 7, 
only 81 lakes pixels has been classified as ‘snow’, 29 as ‘shadows’ and 57 as ‘clouds’ 
on a total of more than 16,000. The number of misclassified pixels is higher in the 
other classes, which are not important for this task objective. If the accuracy for lakes 
class is not high enough, create a new training set and repeat the training operation.  

Re
fe

re
nc

e 
da

ta

Classification results

 
Figure 7. Prediction Tool window – Model Training tab for accuracy evaluation. 

 

o What’s the overall accuracy of the model you have just created? 

The model can now be applied or saved to be used in a second moment. Remember that if 
you want to modify your model in a different session you should save the masks you have 
created. Otherwise, you can only apply the model you have just created. 

 Leave the option in Model Application tab unchanged but enable Output to a new 
target product option and specify file name and path to save the classification results. 

 Apply the model on the image clicking on Apply Model. 

The classification product is thus opened in BEAM-VISAT.  

 Expand ‘Bands’ folder of the new product: it contains, in addition to the source 
product bands, a first band called ‘classification’ (where the number of the 
predominant class is indicated with a value from 0 to 5, indicating the six classes in 
the same order you defined them), and a band for each class containing the 
probability of the pixel to belong to the class itself. 
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 Double click on ‘classification’ band to visualize the classification results (Figure 8). 

 
Figure 8. Classification results of Landsat 8 image of 30th September 2015. See 
Figure 6 for colours legend. 

Let’s now create a mask containing only lakes pixels.  

 Open Colour Manipulation tab and verify the values used in the image to indicate 
‘Lakes’ class. In this case lakes pixels are indicated by the value 5. 

 
Figure 9. Colour Manipulation tab showing colour legend and pixel values coding for 
classification. 

 Open Mask Manager  and click on  to define a mask through a New Logical 
Band Math Expression and type ‘classification==x’ where x is the value for ‘Lakes’ 
class.  

 
Figure 10. New Logical Band Math Expression Editor for the definition of Lakes mask 
on the basis of Prediction Tool classification. 
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 Click OK and a new mask of lakes is generated. Save the products to store the new 
mask in the file. 

o How many pixels have been classified as ‘Lakes’? 

 

Part 2 Lakes type definition and classification 
In this lesson spectral characteristics will be exploited to classify lakes in three different 
classes: blue lakes, turquoise lakes and grey lakes in order to add this information to the 
provided Sagarmatha National Park lakes database.  

In Figure 11 there’s a zoom of some lakes belonging to the three different classes.  

o How would lakes A, B and D appear in False Colour composition? 

A

B

C

D
 

Figure 11. Zoom on some Himalayan lakes belonging to different classes: A) Grey lake, B) 
Blue lake, D) Turquoise lake. Lake pixels in C) belong to different classes. 

The Prediction Tool is exploited once again to classify the lakes: pixels for the training set are 
chosen on the basis of their spectrum shape, comparing it to some sample in situ measures 
of reflectance.  

Activities 
 Open file ‘InSituMeasures.csv’ in a spreadsheet software (e.g. Excel): the spectra 

obtained from four measures in four different lakes are there reported, with the ID 
number of the lake and the class it belongs to. 

 Create a plot of in situ measures: as shown in Figure 12, blue lakes are the less 
reflective, especially in red-infrared region. Each lake type can thus be distinguished 
through the shape of its spectrum. 
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Figure 12. In situ reflectance measurements in four different lakes (ID number is the 
cadastre number of SNP lakes), belonging to classes Blue, Grey and Turquoise. 

 Return to the BEAM software and import measures coordinates: File>Import>Vector 
Data>CSV and choose ‘coordinates_inSituMeasurements.txt’. Specify in the dialog 
window the Coordinate System of coordinates file: Geographic Lat/Lon (WGS 84) and 
select Leave imported data unchanged when BEAM asks for point data interpretation. 

 
Figure 13. Import CSV Data options window, for CRS definition. 

 The coordinates are imported both as vector and as masks and you can manage the 

colour, shape and visibility through Vector Manager  and Mask Manager , 
respectively.  

 Open the Spectrum View : in the window the spectrum of the pixel you are 
pointing with the cursor is shown selecting . Move across the image and look at 
how it changes on different lakes. If you press the ‘Shift’ key while moving, BEAM will 
adjusts the min/max range of the y axis. 
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 Collect the spectra of the measurements stations: select pin placing tool  and click 

on the pixels corresponding to each station. Through Pin Manager  choose a 
colour for each pin and rename each pin with the number ID of each lake. Finally, let 

Spectrum View show spectra for pins clicking on . The result is shown in Figure 14. 

 
Figure 14. Measurements Stations and Spectrum View. Numbers refer to lake ID 
number reported in csv ’InSituMeasures.csv’ file.  

o Compare spectra to in situ measurements: are they similar?  

Observe the position of the four sampled lakes: lake 10, 31 and 24 are not directly fed by 
glacial waters, while lake 161 is placed at the confluence of three glaciers, and its shape 
follows the one of a terminal glacier tongue. This lake is well known and studied  (e.g. Bolch 
et al., 2008; Bayers et al., 2013) because of its risk of outburst since its surface is gradually 
increasing and its basin is not adequate to contain all its waters. Lake 161 is a typical 
example of a lake at risk of GLOF (Glacial Lake Outburst  Flow), born as multiple surface 
ponds on the terminal part of a glacier tongue and evolved as a proglacial lake, as a 
consequence of global climate changes. It also has a grey colour, sign of high concentration 
of suspended sediments. The combination of morphological characteristics (e.g. near the 
glacier and with elongated shape) and biophysical parameters (e.g. water colour), which can 
be observed by EO instruments, give some indication about the risk of such remote lakes of 
causing serious damages to the local population. 

Let’s define training set for the classification of lakes. 

 Keeping enabled the visualization of pins spectra, enable the visualization of the 
spectrum of the pixel pointed by the cursor clicking on .  
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 For each class, use the Magic Wand tool: choose some sample lakes pixels across 
the image comparing their spectrum shape to those in Figure 14 for each class. For 
ex. for class ‘Turquoise’, select pixels with spectrum shape similar to lakes 24, as in 
Figure 15. 

 
Figure 15. Spectrum visualization for pixel pointed by the cursor (black line in 
Spectrum View) similar to turquoise lake 24 spectrum shape. 

Once you have generated three masks containing the training set for each class: 

 Open the Prediction Tool and select again all the available bands of the September 
30th 2015 and select the three masks as training areas as in Figure 16. 

 
Figure 16. Prediction Tool window – Training Set tab for lakes classification in three 
different classes. 

 Evaluate the accuracy of the model clicking Evaluate Model Performance in the 
Model Training tab. 



Global Lakes Sentinel Services (313256) 

 

 

16 of 23 

 Set the model to be applied only on lakes pixels: enable the option ’Use valid pixel 
expression’ and type ’Lakes’ in the row below, which means to consider pixels that 
are comprised in the mask ’Lakes’. 

 Select saving the output to a new target product and choose the name of the file. 

 Save the model in order to use it in the third part of this lesson ( ). 

 Apply the model. 

 
Figure 17. Prediction Tool window – Model Application tab. 

 
Figure 18. Results of the classification of Himalayan lakes on September 30th 2015 
Landsat 8 atmospherically corrected image. 
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The classification results can be now exploited to update the database provided with the 
information on lakes class. 

 Import the database shapefile to visualize lakes position in the image 
(File>Import>Vector Data>Esri Shapefile and choose ‘LAKES_SNP.shp’ file. In the 
vector folder a new vector of points (LAKES_SNP) is created and shown on the 
image with white crosses. 

 For each cross, left click on it (the cross becomes yellow) and click on : the point 
information is shown, including the ID of the lake. 

 For each lake you can add the class it belongs to in the shapefile. 

Part 3 Change detection 

Activities 
In this third part, the model previously trained is applied to a second image acquired on 
October 29th 2014, in order to evaluate meaningful differences in smallest lakes extension 
and class, considering a smaller sample area. 

 Open the classification product of September 30th 2015. 

 Open Mask Manager  and click on . Create a mask for each class typing 
‘classification==x’, where x is the value used in ‘classification’ band to identify each 
class. Rename them as ‘Blue_mask’, ‘Turquoise_mask’ and ‘Grey_mask’. 

 Open Landsat atmospherically corrected image of October 29th 2014 (File>Open 
Product: choose ‘Subset_L8_20141029_AtmCorr.dim’. 

 Repeat the same operation did on 2015 image to generate a lakes mask and called it 
‘Lakes_2014’. 

 Return to 2015 image and open Mask Manager ; select ‘Lakes’ (the corresponding 
table row becomes blue left clicking on the name) and click on  to transfer the 
mask to the 2014 image. Select the option Pixels for the masks transfer (see Figure 
19 for this choice explanation). Masks are now available on 2014 image. 

 
Figure 19. Masks transfer options window. 
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 Open a False Colour view of 2014 image and enable the visibility of ’Lakes’ and 
‘Lakes_2014 masks in Mask Manager to compare lakes extension of the two different 
years. At first glance, the largest lakes did not undergo any change in their extension. 

To evaluate possible changes in lakes colour, apply the model for lakes classification 
previously calibrated: 

 Open the Data Model Application Operator: Processing>Image Analysis>Data Model 
Application. 

 Select as input the subset of 2014 image and set the name and path for the output 
product. 

 In Processing Parameters tab, load the model previously saved in Part 2 of this 
lesson.  

 Enable the processor to Use Valid Pixel Expression and define it as ‘Lakes_2014’.  

 Apply the model. 

The result may appear as in Figure 20 where few pixels are classified. 

 
Figure 20. Result obtained applying a sample classification model calibrated on 2015 image 
to 2014 image.  

 In this case, open the band of the output product showing probability for each class: 
probability values are below the default threshold of 0.5 where pixels haven’t been 
classified. This is probably due to small differences in reflectance values but not in 
shape as it can be assessed looking at Spectrum View for this second image. In this 
case, the model can be applied again increasing the value x (where: probability 
threshold=1-x) in the Model Application tab. In this way pixels are assigned to the 
class with the highest probability, without any condition on minimum probability value. 
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Compare 2015 and 2014 results:  

 Create a mask for each class on 2014 classification product as previously did for 
2015 classification product, calling them ‘Blue_mask_2014’, ‘Turquoise_mask_2014’ 
and ‘Grey_mask_2014’. 

o What’s the percentage of pixels classified as blue/grey/turquoise lakes in 2014? 

o What’s the percentage of pixels classified as blue/grey/turquoise lakes in 2015 
considering the same area included in 2014 subset? 

o Is there any change between these two consecutive years? 

 

Part 4 Evaluation of new grey lakes on glacier tongues 
The most evident changes are in the smallest lakes located in the tongues, for ex. in the red 
box in Figure 21 the two central tongues in the 2014 subset are shown: in 2015 the 
sediments rich grey lakes (which appears light blue in the False Colour composition) are 
larger than in 2014. 

 
Figure 21. False Colour composition of Landsat 8 image of October 29th 2014 (top and a 
zoom on the area in the red box on the same date (left bottom) and on September 30th 2015. 

This phenomenon could be the precursor of the creation of lake similar to lake 161 (See Part 
1). To define the extension of these lakes. In this third part we try to identify the extension 
and colour of new lakes in two glacier tongues. 
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Activities 
As you previously did, collect spectra with Magic Wand in order to define two classes on 
2014 image: ponds and glacier tongues: 

 Open Magic Wand tool and collect spectra for both classes, calling them 
‘Ponds_2014’ and ‘Glacier_tongues_2014’ 

 With , crate a new geometry and call it ‘Tongues’. With the Polygon drawing tool 
, draw two polygons including only the two tongues in the image on 2014 and then 

transfer the new mask ‘Tongues’ to 2015 image. 

 Generate a mask for each class intersecting the mask created with Magic Wand with 
‘Tongues’ mask: in Mask Manager select ‘Tongues’ mask and ‘Glacier_tongues_2014’ 
and click on . Repeat the same for ‘Ponds_2014’ mask. 

 Open Prediction tool and train the model using these last two generated masks as 
training set. If the accuracy is satisfying, apply the model, using as valid pixel value 
expression the string ‘Tongues’, to include the area of tongues only. 

 Save the model and apply it on 2015 image, again only on the area of tongues.  
 

o How many pixels are classified as ponds in 2014? And in 2015? Are there any 
differences? 
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4 More information and further reading 
This lesson is based on the following report:  

• GLaSS Deliverable 5.4, 2015.  Global Lakes Sentinel Services, D5.4: Shallow lakes 
with low transparency due to sediment resuspension. WI, CNR, VU/VUmc in 
cooperation with Witteveen+Bos. Available via: http://www.glass-
project.eu/downloads/ 

 

The report is suggested for further reading. It contains processed data for SNP area, but also 
for the following shallow lakes: 

• Lake Markermeer 

• Lake Böyük Şor 

For more information on GLaSS, and to download all public reports: www.glass-project.eu.
  

http://www.glass-project.eu/downloads/
http://www.glass-project.eu/downloads/
http://www.glass-project.eu/
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